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ВВЕДЕНИЕ 
 

 

Изучение дисциплины «Начертательная геометрия, Инженерная и 
компьютерная графика» даёт возможность студентам инженерно-
технических специальностей читать и выполнять чертежи и схемы – 
изображения изделий, связанные соответствующим образом с проек-
тированием, изготовлением и эксплуатацией различных машин, меха-
низмов и приборов. 

Практикум предназначен для студентов, обучающихся по направ-
лениям подготовки дипломированных специалистов и бакалавров в 
области техники и технологии.  

Приведена информация о способах создания и редактирования 
изображений в графическом редакторе AUTOCAD. 

Представлены графические задания по начертательной геомет-
рии, состоящие из графических задач по всем темам рабочих учебных 
программ соответствующих специальностей и примеров их выполне-
ния с использованием графического редактора. Выполнение заданий 
способствует приобретению будущими дипломированными специали-
стами и бакалаврами знаний общих методов построения и чтения чер-
тежей, а также решению разнообразных инженерно-геометрических 
задач, возникающих при проектировании, конструировании и изготов-
лении различных изделий. 

Полное владение чертежом как производственным документом, а 
также устойчивость навыков в выполнении чертежей достигаются в 
результате изучения специальных инженерно-технических дисциплин 
соответствующего профиля, подкреплённого практикой курсового и 
дипломного проектирования. 
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1. ОСНОВЫ КОМПЬЮТЕРНОЙ ГРАФИКИ 
 

 
1.1. ПОСТРОЕНИЕ ОБЪЕКТОВ 

 
1.1.1. ОБЪЕКТНАЯ ПРИВЯЗКА КООРДИНАТ 

 

Объектная привязка – наиболее быстрый способ точно указать 
точку на объекте, не обязательно зная её координаты, а также постро-
ить вспомогательные линии. Например, объектная привязка позволяет 
построить отрезок от центра окружности, от середины сегмента поли-
линии, от реального или видимого пересечения объектов. Объектную 
привязку можно задать в любой момент, когда AutoCAD  ожидает вво-
да координат точки. В этом случае указанный режим применяется 
только к следующему выбранному объекту. Кроме того, имеется воз-
можность установки одного или нескольких режимов объектной при-
вязки в качестве текущих. Таким образом, активизация объектной 
привязки может осуществляться двумя способами:  

– разовые режимы объектной привязки, действующие при указа-
нии только текущей (одной) точки;  

– текущие режимы объектной привязки, действующие постоянно 
до их отключения.  

Режимы объектной привязки выбираются на плавающей панели 
инструментов Object Snap (рис. 1.1).  

 

 
 

Рис. 1.1. Панель инструментов объектной привязки 
 
Можно для выбора ключей объектной привязки использовать 

контекстное меню, которое вызывается щелчком правой кнопки мыши 
в любом месте области рисования при нажатой клавише Shift. В ре-
жиме объектной привязки точка помечается маркером; его форма за-
висит от используемого режима, имя которого появляется возле точки 
в виде подсказки.  

Конечная точка. Snap to Endpoint – привязка к ближайшей из 
конечных точек объектов (отрезков, дуг и т.п.). В случае пространст-
венного моделирования, если объект имеет ненулевую высоту, допус-
кается привязка к его нижней и верхней границам. В режиме Endpoint 
привязка может производиться к границам трёхмерных тел и областей, 
например к конечной точке (вершине) параллелепипеда.  
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Рис. 1.2. Построение с привязкой к конечным точкам 
 
Средняя точка. Snap to Midpoint – привязка к средним точкам 

объектов (отрезков, дуг и т.п.). Привязка для бесконечных прямых и 
лучей производится к первой из определяющих их точек. Для сплай-
нов и эллипсов в режиме Midpoint  осуществляется привязка к точке 
объекта, расположенной на равных расстояниях от начальной и конеч-
ной точек. В случае пространственного моделирования, если отрезок 
или дуга имеет ненулевую высоту, можно осуществлять привязку к 
серединам верхней и нижней границ объекта. Режим Midpoint позво-
ляет также производить привязку к границам трёхмерных тел и облас-
тей. 

 

 
 

Рис. 1.3. Построение с привязкой к средним точкам 
 

Пересечение. Snap to Intersection – привязка к точкам пересече-
ний объектов (отрезков, окружностей, дуг, сплайнов и т.п.).  
В случае пространственного моделирования в режиме Intersection до-
пускается привязка к угловым точкам объектов, имеющих ненулевую 
высоту выдавливания. Если два таких объекта с пересекающимися 
основаниями имеют одинаковое направление выдавливания, можно 
произвести привязку к пересечениям их верхней и нижней границ. 
Режим Intersection позволяет выполнить привязку к точке воображае-
мого пересечения двух любых объектов. Если в прицел попадает толь-
ко один из объектов, AutoCAD предлагает указать второй и произво-
дит привязку к точке, в которой эти объекты пересекались бы при их 
естественном удлинении. Режим расширенного пересечения Extended 
Intersection включается автоматически при выборе режима объектной 
привязки Intersection.  
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Рис. 1.4. Построение с привязкой к точкам пересечения 
 
Предполагаемое сечение. Snap to Apparent Intersection – при-

вязка к точке видимого на экране предполагаемого пересечения. Ре-
жим Apparent Intersection ищет точку пересечения двух объектов, 
которые не имеют явной точки пересечения в пространстве. Режим 
предполагаемого пересечения обеспечивает эффективную работу с 
границами областей и кривыми, но не работает с границами и углами 
трёхмерных тел. Если объекты находятся в одной плоскости, то опи-
сываемый режим повторяет возможности режима Intersection. Режим 
Apparent Intersection включает в себя два отдельных режима: собст-
венно Apparent Intersection и расширенное кажущееся пересечение 
Extended Apparent Intersection. Привязка в этих режимах может при-
меняться к пересечениям границ областей и кривых, кроме криволи-
нейных границ трёхмерных тел. В режиме Apparent Intersection вы-
полняется привязка к точке пересечения двух объектов, которые ре-
ально не пересекаются в трёхмерном пространстве, но на текущем ви-
де выглядят пересекающимися. Режим Extended Apparent 
Intersection позволяет осуществить привязку к точке воображаемого 
пересечения двух любых объектов. Режим Extended Apparent 
Intersection включается автоматически при выборе режима объектной 
привязки Apparent Intersection; при этом он активен тогда, когда в 
прицел попадает только один объект и другие режимы объектной при-
вязки отключены. Оба указанных режима могут использоваться как 
для разовой привязки точки, так и в качестве текущих режимов при-
вязки.  

 

 
 

Рис. 1.5. Построение с привязкой к точкам предполагаемого пересечения 
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Точка центра. Snap to Center – привязка к центру дуги, окруж-
ности или эллипса. При использовании режима Center необходимо 
указывать мышью на линию дуги, окружности или эллипса, а не на их 
центр. В этом режиме можно осуществлять привязку и к центрам ок-
ружностей, являющихся частью тел и областей. При привязке к центру 
нужно выбирать видимую часть дуги, окружности или эллипса.  

 

 
 

Рис. 1.6. Построение с привязкой к центру 
 
Квадрант. Snap to Quadrant – привязка к ближайшему квадран-

ту (точке, расположенной под углом 0°, 90°, 180° или 270° от центра) 
дуги, окружности или эллипса. Расположение точек квадрантов ок-
ружностей и дуг определяется текущей ориентацией ПСК. Если дуга, 
окружность или эллипс входят в блок, вставленный с ненулевым углом 
поворота, точки квадрантов ориентируются в соответствии с этим уг-
лом.  

Касательная. Snap to Tangent – привязка к точке на дуге, ок-
ружности, эллипсе или плоском сплайне, принадлежащей касательной 
к другому объекту. С помощью режима объектной привязки Tangent 
можно, например, построить по трём точкам окружность, касающуюся 
трёх других окружностей. При выборе точки на дуге, полилинии или 
окружности в качестве первой точки привязки в режиме Tangent ав-
томатически активизируется режим задержанной касательной 
Deferred Tangent, который может быть использован для построения 
окружностей по двум и трём точкам, при формировании окружности, 
касательной к трём другим объектам. Для сплайнов и эллипсов вторая 
указанная точка должна лежать в той же плоскости, что и точка при-
вязки.  

При совместном использовании режимов привязки From и 
Tangent для построения объектов, отличных от касательных отрезков 
к дугам и окружностям, первая точка объекта лежит на касательной к 
дуге или окружности, проведённой через последнюю указанную в про-
странстве рисунка точку.  
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Рис. 1.7. Построение касательной 
 
Нормаль. Snap to Perpendicular – привязка к точке объекта, ле-

жащей на нормали к другому объекту или к его воображаемому про-
должению. Режим Perpendicular может использоваться для таких объ-
ектов, как отрезки, окружности, эллипсы, сплайны и дуги. Если режим 
привязки Perpendicular применяется для указания первой точки от-
резка или окружности, происходит построение отрезка или окружно-
сти, перпендикулярных выбранному объекту. Если должна быть ука-
зана вторая точка отрезка или окружности, AutoCAD  производит при-
вязку к точке объекта, которая принадлежит нормали, проведённой к 
первой указанной точке. Вектором нормали в любой точке сплайна 
является вектор, перпендикулярный касательной в данной точке. Если 
указанная пользователем точка лежит на сплайне, то в режиме 
Perpendicular она будет считаться одной из возможных точек привяз-
ки. В некоторых случаях при работе со сплайнами положение точек 
привязки оказывается неочевидным. Кроме того, для некоторых 
сплайнов в данном режиме объектной привязки таких точек может 
вообще не существовать.  

 

 
 

Рис. 1.8. Построение нормали 
 
Выбор режимов привязки. Object Snap Setti ngs – установка 

режима текущей объектной привязки на вкладке Object Snap диалого-
вого окна Drafting Settings (рис. 1.9). Это окно также загружается из 
падающего меню Tools > Drafting Settings... или из контекстного ме-
ню, которое вызывается при щелчке правой кнопки мыши по кнопке 
OSNAP в строке состояния и последующем выборе пункта Settings. 
Если требуется несколько раз подряд произвести привязку определён-
ного типа (например, к конечным точкам или центрам), можно задать 
один или несколько текущих режимов объектной привязки. Следует 
иметь в виду, что режим объектной привязки From не может быть ус-
тановлен текущим.  
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Рис. 1.9. Диалоговое окно установки режима текущей объектной привязки 
 
Специальные средства повышения наглядности, называемые ав-

топривязкой Auto-Snap, облегчают выбор точек привязки и повышают 
эффективность использования объектной привязки. Средства автопри-
вязки включают в себя следующие элементы:  

• маркеры обозначают тип объектной привязки в точке привяз-
ки с помощью соответствующего символа;  

• всплывающие подсказки автопривязки поясняют тип объект-
ной привязки в точке привязки ниже позиции указателя мыши;  

• магнит автоматически перемещает в точку привязки указатель 
мыши, если он находится около возможной точки привязки;  

• прицел окружает перекрестье указателя мыши и ограничивает 
область рисунка, в пределах которой при перемещении указателя оп-
ределяются возможные точки привязки.  

Для включения или отключения сразу всех текущих режимов 
объектной привязки без вызова диалогового окна Drafting Settings 
необходимо щёлкнуть по кнопке OSNAP в строке состояния (или на-
жать клавиши Ctrl + F  или F3).  

Полярное отслеживание. Полярное отслеживание облегчает 
выбор точек, лежащих на воображаемых линиях, которые можно про-
вести через последнюю указанную в команде точку под одним из за-
данных полярных углов. Если, например, шаг углов полярного отсле-
живания равен 45°, линии отслеживания и всплывающие подсказки 
могут появляться под углами, кратными 45° относительно текущего 
направления отсчёта углов. Полярное отслеживание может осуществ-
ляться под углами, кратными следующим стандартным значениям: 
90°; 45°; 30°; 22,5°; 18°; 15°; 10° или 5°. Для включения полярного от-
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слеживания необходимо нажать функциональную клавишу F10 или 
кнопку POLAR в строке состояния. При включении полярного отсле-
живания отключается режим ORTHO . Изменение параметров поляр-
ного отслеживания осуществляется на вкладке Polar Tracking  диало-
гового окна Drafting Settings (рис. 1.10). Это окно загружается из па-
дающего меню Tools > Drafting Settings... или из контекстного меню, 
которое вызывается при щелчке правой кнопкой мыши по кнопке 
POLAR  в строке состояния и последующем выборе пункта Settings.  

 

 
 

Рис. 1.10. Диалоговое окно изменения параметров полярного отслеживания 
 

1.1.2. ПОСТРОЕНИЕ ЛИНИЙ 
 

Линия в AutoCAD  является базовым примитивом. Линии бывают 
различного рода – одиночные отрезки, ломаные (с сопряжениями ду-
гами или без них), пучки параллельных линий (мультилинии), а также 
эскизные. Линии рисуют, задавая координаты точек, свойства (тип, 
цвет и др.), значения углов.  

Отрезок. Команда LINE  формирует отрезок и вызывается из па-
дающего меню Draw > Line или щелчком мыши по пиктограмме Line 
на панели инструментов Draw. Запросы команды LINE: Specify first 
point: – указать первую точку Specify next point or [Undo]: – указать 
следующую точку Specify next point or [Undo]: Specify next point or 
[Close/Undo]: Specify next point or [Close/Undo]:  

Запросы команды LINE  организованы циклически. Цикл закан-
чивается после нажатия клавиши Enter в ответ на очередной запрос 
Specify next point or [Close/Undo]. К аналогичному результату приве-
дёт щелчок правой кнопкой мыши с последующим выбором пункта 
Enter из появившегося контекстного меню (рис. 1.11).  
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Рис. 1.11. Контекстное меню Ключи команды LINE: 
Close – замкнуть ломаную; 

Undo – отменить последний нарисованный отрезок 

 
Прямая и луч. В AutoCAD 2009 допускается построение линий, 

не имеющих конца в одном или в обоих направлениях. Такие линии 
называются соответственно лучами и прямыми. Их можно использо-
вать в качестве вспомогательных при построении других объектов. 
Наличие бесконечных линий не изменяет границ рисунка.  

Ключи команды XLINE : 
• Ноr  – построение горизонтальной прямой, проходящей через 

заданную точку;  
• Ver – построение вертикальной прямой, проходящей через за-

данную точку;  
• Ang – построение прямой по точке и углу. Есть два способа 

задать угол для построения прямых. Можно либо выбрать опорную 
линию и указать угол между нею и прямой, либо (для построения пря-
мой, лежащей под определённым углом к горизонтальной оси) указать 
угол и точку, через которую должна проходить прямая; 

• Bisect – по точке и половине угла, заданного тремя точками. 
При этом создаётся прямая, делящая какой-либо угол пополам. Нужно 
указать вершину угла и определяющие его линии;  

• Offset – по смещению от базовой линии. При этом создаётся 
прямая, параллельная какой-либо базовой линии. Следует задать вели-
чину смещения, выбрать базовую линию, а затем указать, с какой сто-
роны от базовой линии должна проходить прямая.  

Полилиния. Команда PLINE, формирующая полилинию, вызы-
вается из падающего меню Draw > Polyline или щелчком мыши по 
пиктограмме Polyline на панели инструментов Draw. Полилиния пред-
ставляет собой связанную последовательность линейных и дуговых 
сегментов и обрабатывается системой как графический примитив. По-
лилинии используют, если требуется работа с набором сегментов как 
целым, хотя допускается их редактирование по отдельности.  
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Ключи команды PLINE :  
• Arc  – обеспечивает переход в режим дуг;  
• Close – замыкает полилинию отрезком. Замыкающий отрезок 

существенно отличается от обычного, проведённого от конечной точки 
к начальной. Они по-разному обрабатываются при редактировании и 
сглаживании полилиний, а также при подрезке углов стыков широких 
сегментов. Практически всегда предпочтительно использовать замы-
кающие отрезки;  

• Half width  – позволяет задать полуширину, т.е. расстояние от 
осевой линии широкого сегмента до края;  

• Length – задает длину сегмента, созданного как продолжение 
предыдущего в том же направлении;  

• Undo – отменяет последний созданный сегмент; 
• Width  – позволяет задать ширину последующего сегмента. 

AutoCAD запрашивает начальную и конечную ширину. Введённое 
значение начальной ширины автоматически предлагается установить 
значением конечной ширины по умолчанию. Начальная и конечная 
точки широких линейных сегментов лежат на оси полилинии.  

Ключи команды PLINE  в режиме построения дуг:  
• Angle – ввести центральный угол. По умолчанию дуга отрисо-

вывается против часовой стрелки. Если требуется отрисовка дуги по 
часовой стрелке, необходимо задать отрицательное значение угла;  

• CEnter – указать центр дуги;  
• CLose – замкнуть дугой;  
• Direction – задать направление касательной;  
• Half width  – определить полуширину полилинии;  
• Line – перейти в режим построения отрезков;  
• Radius – ввести радиус дуги;  
• Second pt – указать вторую точку дуги по трём точкам. Если 

дуга не является первым сегментом полилинии, то она начинается в 
конечной точке предыдущего сегмента и по умолчанию проводится по 
касательной к нему;  

• Undo – отменить последнюю точку;  
• Width  – определить ширину полилинии.  
Заметим, что дуговые сегменты полилинии задаются любым из 

способов, характерных для команды формирования дуги ARC – см. 
соответствующий раздел данной главы. Кроме того, такие сегменты 
можно построить, задав радиус, центральный угол и направление хор-
ды. Это единственный случай, когда дуга, предлагаемая по умолча-
нию, не строится по касательной. 



13 

 
 

Рис. 1.12. Построение полилинии с установкой толщины 
 

 
 

Рис. 1.13. Построение полилинии в режиме дуг 
 
Мультилиния. Команда MLINE , формирующая мультилинию, 

вызывается из падающего меню Draw > Multiline  или щелчком мыши 
по пиктограмме Multiline  на панели инструментов. Мультилиния со-
стоит из пучка параллельных линий, называемых её элементами (рис. 
1.14). Чтобы расставить элементы, необходимо указать смещение каж-
дого из них относительно исходной точки. Мультилинии могут иметь 
торцевые ограничители различного вида, например отрезки или дуги.  

 

 
 

Рис. 1.14. Примеры мультилиний 
 
Ключи команды MLINE :  
• Justification – определение положения точки начала черчения: 

Тор – верх, Zero – центр, Bottom – низ. Линия проходит соответст-
венно с максимальным положительным, с нулевым или максимальным 
отрицательным смещением от заданной точки;  

• Scale – коэффициент масштабирования. Смещение между ли-
ниями равняется заданному коэффициенту, умноженному на величину 
Offset, определённую в стиле;  
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• Style – выбор стиля. При построении мультилиний использу-
ется стиль мультилинии. Он создаётся в диалоговом окне Multiline 
Styles, которое вызывается из падающего меню Format > Multiline 
Style... (рис. 1.16). Щелчком мыши по кнопке Load... можно загрузить 
существующий стиль; сохранить вновь созданный на диске – нажати-
ем кнопки Save..., добавить свой – нажатием кнопки Add. Имя добав-
ляемого стиля должно быть задано в текстовом поле Name:. По умол-
чанию используется стиль STANDARD.  

 

 
 

Рис. 1.15. Диалоговое окно создания стилей мультилинии 
 

Свойства элементов мультилинии определяются в диалоговом 
окне Element Properties (рис. 1.16):  

− в области Offset определяется смещение линий мультилинии 
друг относительно друга;  

− нажатие кнопки Linetype... выводит на экран диалоговое окно 
определения типа линии;  

− нажатие кнопки Color... загружает диалоговое окно определе-
ния цвета каждой линии.  
 

 
 

Рис. 1.16. Диалоговое окно определения свойств элемента мультилинии 
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Свойства мультилинии определяются в диалоговом окне 
Multiline  Properties (рис. 1.17):  

− в области Fill  установкой флажка On обеспечивается заполне-
ние мультилинии цветом;  

− в области формирования торцов Caps определяется вид кон-
цевых элементов;  

− в поле Angle определяется величина угла наклона концевого 
элемента к мультилинии. По умолчанию используется файл стиля с 
именем acad.mln.  

 

 
 

Рис. 1.17. Диалоговое окно определения свойств мультилинии 
 

Системная переменная CMLSTYLE  содержит имя текущего сти-
ля мультилинии.  

Многоугольник. Команда POLYGON , обеспечивающая форми-
рование правильного многоугольника, вызывается из падающего меню 
Draw > Polygon или щелчком мыши по пиктограмме Polygon на пане-
ли инструментов Draw. Запросы команды POLYGON : Enter number 
of sides <default>: – указать число сторон Specify center of polygon or 
[Edge]: – указать центр многоугольника. 

Ключи команды POLYGON: 
• Edge – указание одной стороны. При использовании этого 

ключа команда POLYGON  выдаёт следующие запросы:  
− Specify first endpoint of edge: – указать первую конечную точ-

ку стороны; 
− Specify second endpoint of edge: – указать вторую конечную 

точку стороны;  
• При указании центра многоугольника команда POLYGON  

выдает следующие запросы: Enter an option [Inscribed in circle 
/Circumscribed about circle] <I>: – задать опцию размещения Specify 
radius of circle:– задать радиус окружности где:  

• Inscribed in circle – формирование многоугольника, вписанно-
го в окружность;  

• Circumscribed about circle – формирование многоугольника, 
описанного вокруг окружности.  
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Рис. 1.18. Построение многоугольника по известной стороне 
 
 

 
 

Рис. 1.19. Построение вписанного многоугольника 
 
 

 
 

Рис. 1.20. Построение описанного многоугольника 

 
1.1.3. ПОСТРОЕНИЕ КРИВОЛИНЕЙНЫХ ОБЪЕКТОВ 

Сплайн. Команда SPLINE – формирующая сплайн, вызывается 
из падающего меню Draw > Spline или щелчком мыши по пиктограм-
ме Spline на панели инструментов Draw. Сплайн представляет собой 
гладкую кривую, проходящую через заданный набор точек. AutoCAD  
работает с одной из разновидностей сплайнов – неоднородными ра-
циональными В-сплайновыми кривыми NURBS. Использование 
NURBS обеспечивает достаточную гладкость кривых, проходящих 
через заданные контрольные точки.  



17 

Окружность. Команда CIRCLE , формирующая окружность, вы-
зывается из падающего меню Draw > Circle или щелчком мыши по 
пиктограмме Circle на панели инструментов Draw. Окружности можно 
строить различными способами. По умолчанию построение произво-
дится путём указания центра и радиуса. Можно задавать центр и диа-
метр или только диаметр, указывая его начальную и конечную точки. 
Окружность также может строиться по трём точкам. Кроме того, име-
ется возможность определять окружность, касающуюся либо трёх объ-
ектов рисунка, либо двух (в последнем случае задаётся ещё и радиус). 
При использовании этого ключа команда CIRCLE  выдаёт следующие 
запросы:  

 
 

Рис. 1.21. Построение окружности по центру и радиусу 
 

 
 

Рис. 1.22. Построение окружности по двум точкам диаметра 
 

 
 

Рис. 1.23. Построение окружности по трём точкам 
 

 
 

Рис. 1.24. Построение окружности, касательной двум примитивам 
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Рис. 1.25. Построение окружности, касательной двум другим окружностям 
 

 
 

Рис. 1.26. Построение окружности, касательной прямой 
 

 
 

Рис. 1.27. Построение окружности по двум точкам диаметра,  
лежащим на концах отрезка 

 

 
 

Рис. 1.28. Построение концентрической окружности 
 
Дуга. Команда ARC, формирующая дугу», вызывается из па-

дающего меню Draw >Arc  или щелчком мыши по пиктограмме Arc  на 
панели инструментов Draw. По умолчанию построение производится 
путём указания трёх точек: начальной, промежуточной и конечной. 
Дугу можно также определить, задав центральный угол, радиус, на-
правление или длину хорды. Хордой называется отрезок, соединяю-
щий начало и конец дуги. По умолчанию дуга рисуется против часо-
вой стрелки. Ключи команды ARC:  
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• Center – точка центра дуги;  
• End – конечная точка дуги;  
• Angle – величина угла;  
• chord Length – длина хорды;  
• Direction – направление касательной;  
• Radius – радиус дуги.  
• Specify start point of arc or [CEnter]: – указать начальную 

точку дуги; 
• Specify end point of arc: – указать конечную точку дуги.  
 

 
 

Рис. 1.29. Построение дуги по трём точкам 
 

 
 

Рис. 1.30. Построение дуги по стартовой точке, центру и углу 
 

 
 

Рис. 1.31. Построение дуги по стартовой точке, центру и углу 
 
Эллипс. Команда ELLIPSE , обеспечивающая формирование эл-

липса, вызывается из падающего меню Draw > Ellipse или щелчком 
мыши по пиктограмме Ellipse на панели инструментов Draw. Самая 
длинная ось эллипса называется его большой осью, самая короткая – 
малой (рис. 1.32). Ключи команды ELLIPSE : 

• Center – указание центра эллипса. Запросы:  
− Specify axis endpoint of ellipse or [Arc/Center]: С – переход в 

режим указания центра эллипса; 
− Specify center of ellipse: – указать центр эллипса; 
− Specify endpoint of axis:– указать конечную точку оси; 
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− Specify distance to other axis or [Rotation]: – указать длину 
другой оси;  

• Arc  – режим построения эллиптических дуг. По умолчанию 
эллиптические дуги, как и эллипсы, строятся путём указания конечных 
точек первой оси и половины длины второй. После этого задаются 
начальный и конечный углы.  

 

 
 

Рис. 1.32. Построение эллипса 
 
Кольцо. Команда DONUT формирует кольца и вызывается из 

падающего меню Draw > Donut или щелчком мыши по пиктограмме 
Donut. С помощью функции построения колец легко строить закра-
шенные кольцеобразные объекты и круги. В действительности они 
представляют собой замкнутые полилинии ненулевой ширины. Если 
требуется построить заполненный круг, следует задать нулевой внут-
ренний диаметр кольца. Текущее значение внутреннего диаметра 
кольца хранится в системной переменной DONUT ID , а значение 
внешнего диаметра – в переменной DONUT OD. Закраской колец и 
широких полилиний управляет системная переменная FILLMODE .  

 

 
 

Рис. 1.33. Построение кольца 

 
1.2. КОМАНДЫ ОФОРМЛЕНИЯ ЧЕРТЕЖЕЙ 

 

1.2.1. ШТРИХОВКА 
 

Штрихование – это заполнение указанной области по определён-
ному образцу. Команда ВНАТСН, формирующая ассоциативную 
штриховку, вызывается из падающего меню Draw > Hatch... или 
щелчком мыши по пиктограмме Hatch на панели инструментов Draw. 
При обращении к команде ВНАТСН загружается диалоговое окно 
Boundary Hatch and Fill, показанное на рис. 1.34.  
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Рис. 1.34. Диалоговое окно штриховки 
 
Команда ВНАТСН позволяет наносить не только ассоциативную, 

но и неассоциативную штриховку. Ассоциативность здесь означает, 
что при изменении границ контура изменяется и штриховка. Неассо-
циативная штриховка не зависит от контура границы. В программе 
имеется 14 образцов штриховки, удовлетворяющих стандартам ISO 
(Международной организации по стандартизации). Для штриховки по 
стандарту ISO можно задать ширину пера, которая определяет вес ли-
нии образца. Выбор образца штриховки осуществляется в области 
Pattern:. Удобно пользоваться как раскрывающимся списком, так и 
диалоговым окном Hatch Pattern Palette, показанным на рис. 1.35 – 
там содержатся пиктограммы с графическими образцами различных 
штриховок. Для выбора образца штриховки достаточно указать его 
изображение.  

 

 
 

Рис. 1.35. Диалоговое окно с образцами штриховки 
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Для использования стандартных образцов штриховок необходимо 
в области Туре: выбрать из раскрывающегося списка пункт Predefined. 
Имя образца штриховки запоминается в системной переменной 
HPNAME . Текстовые поля Scale: и Angle: позволяют задать масштаб-
ный коэффициент и угол наклона для выбранного образца штриховки. 
При этом введённые параметры запоминаются в системных перемен-
ных HPSCALE и HPANG. 

Чтобы создать новый пользовательский образец штриховки, надо 
в области Туре: выбрать из раскрывающегося списка пункт User 
defined. При этом следует задать угол наклона в поле Angle:, расстоя-
ние между линиями штриховки – в поле Spacing: и, если необходимо, 
поставить флажок Double для отрисовки дополнительных линий под 
углом 90° к основным линиям штриховки. В закладке Gradient диало-
гового окна Boundary Hatch and Fill, показанного на рис. 1.36, уста-
навливаются параметры градиентной заливки.  

 

 
 

Рис. 1.36. Диалоговое окно градиентной заливки 
 
Ассоциативность штриховки устанавливается в области 

Composition выбором одного из параметров: Associative или 
Noassociative. Для автоматического определения контура штриховки 
путём указания точек необходимо нажать кнопку Pick Points. При 
этом выдается запрос: Select internal point: – указать внутреннюю 
точку; Selecting everything... – осуществляется выбор всех объектов; 
Selecting everything visible... – осуществляется выбор всех видимых 
объектов; Analyzing the selected data... – осуществляется анализ вы-
бранных данных; Analyzing internal islands ...– осуществляется анализ 
внутренних островков; Select internal point: – указать внутреннюю 
точку; Analyzing internal islands... – осуществляется анализ внутрен-
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них островков; Select internal point: – нажать клавишу Enter по за-
вершении выбора штрихуемой области, при определении нескольких 
контуров штриховки необходимо выбрать несколько внутренних то-
чек, а затем клавишу Enter.  

По умолчанию AutoCAD  определяет контуры путём анализа всех 
замкнутых объектов рисунка. Когда штрихование производится сти-
лем Normal, островки остаются незаштрихованными, а вложенные 
островки штрихуются, как показано на рис. 1.37. При этом штрихова-
ние производится вовнутрь, начиная от внешнего контура. Если обна-
ружено внутреннее пересечение, штрихование прекращается, а на сле-
дующем пересечении возобновляется. Таким образом, данный стиль 
задаёт штрихование областей, отделённых от внешней части нечётным 
числом замкнутых контуров; области, отделённые чётным числом кон-
туров, не штрихуются. При использовании игнорирующего Ignore и 
внешнего стиля Outer штриховка аналогичного контура выглядит 
иначе (рис. 1.38, 1.39). Стиль Ignore задаёт штрихование всей области, 
ограниченной внешним контуром, без учёта вложенных контуров. 

 

 
 

Рис. 1.37. Пример контура, заштрихованного стилем Normal 
 

 
 

Рис. 1.38. Пример контура, заштрихованного стилем Ignore 
 
При использовании стиля Outer штрихование производится от 

внешнего контура и окончательно прекращается при первом обнару-
женном пересечении. Стили Normal, Ignore и Outer устанавливаются 
в области Island detection style на вкладке Advanced диалогового окна 
Boundary Hatch (рис. 1.40). Если на пути линии штриховки встреча-
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ются текст, атрибут, форма, полоса или закрашенная фигура и данный 
объект входит в набор контуров, AutoCAD  не наносит на него штри-
ховку. В результате, например, читаемость текста, размещённого 
внутри заштрихованного контура, не ухудшается. Если же перечис-
ленные объекты также нужно заштриховывать, следует воспользовать-
ся стилем Ignore.  

 
 

Рис. 1.39. Пример контура, заштрихованного стилем Outer 
 

 
 

Рис. 1.40. Диалоговое окно определения стилей штриховки 
 

Выбор образца штриховки можно осуществить в окне инструмен-
тальной палитры, перетащив образец штриховки на заданный контур. 

 
1.2.2. ПРОСТАНОВКА РАЗМЕРОВ 

 

Размеры показывают геометрические величины объектов, рас-
стояния и углы между ними, координаты отдельных точек.  
В AutoCAD  используется 11 видов размеров, которые можно разде-
лить на три основных типа: линейные (рис. 1.41 – 1.43), радиальные 
(рис. 1.44) и угловые (рис. 1.45). Линейные размеры делятся на гори-
зонтальные, вертикальные и параллельные, повёрнутые, ординатные, 
базовые и размерные цепи. Ниже будут приведены простые примеры 
их нанесения. 
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Рис. 1.41. Горизонтальный, вертикальный и параллельный размеры 
 

 
 

Рис. 1.42. Базовые размеры 
 

 
 

Рис. 1.43. Размерные цепи 
 

 
 

Рис. 1.44. Радиальные размеры 
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Рис. 1.45. Угловые размеры 
 
Команды простановки размеров находятся в падающем меню 

Dimension.  
Для удобства можно воспользоваться пиктограммами на одно-

имённой панели инструментов (рис. 1.46). 
 

 
 

Рис. 1.46. Падающее меню и панель инструментов Dimension 
 
В изображения размеров входят следующие составные элементы:  
• размерная линия – линия со стрелками на концах, выполнен-

ная параллельно соответствующему измерению. Как правило, размер-
ные линии помещаются между выносными. Если на короткой размер-
ной линии не хватает места, размерные стрелки или текст размещают-
ся снаружи в зависимости от настроек размерного стиля. Для угловых 
размеров размерной линией является дуга;  

• размерные стрелки – стрелки, засечки или произвольный мар-
кер, определяемый как блок, для обозначения концов размерной линии;  

• выносные линии проводятся от объекта к размерной линии. 
Могут быть построены перпендикулярно ей или быть наклонными. 
Формируются только для линейных и угловых размеров (используют-
ся, если размерная линия находится вне образмериваемого объекта);  
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• размерный текст – текстовая строка, содержащая величину 
размера и другую информацию (например, обозначения диаметра, ра-
диуса, допуска). Это необязательный элемент, т.е. его вывод на рису-
нок можно подавить. Есть возможность принять размер, автоматиче-
ски вычисленный AutoCAD , или заменить его другим текстом. Если 
принимается текст по умолчанию, к нему можно автоматически доба-
вить допуски и ввести префикс и суффикс;  

• выноски используются, если размерный текст невозможно 
расположить рядом с объектом;  

• маркер центра – небольшой крестик, отмечающий центр ок-
ружности или дуги;  

• осевые линии – линии с разрывом (штрихпунктирные), пере-
секающиеся в центре окружности или дуги и делящие ее на квадранты.  

Все линии, стрелки, дуги и элементы текста, составляющие размер, 
будут рассматриваться как один размерный примитив, если установлен 
режим ассоциативного образмеривания. Ассоциативные размеры изменя-
ются в соответствии с изменением элементов, которые образмериваются.  

Линейные размеры. AutoCAD обеспечивает несколько видов 
простановки линейных размеров, отличающихся углом, под которым 
проводится размерная линия. Команда DIMLINEAR  позволяет созда-
вать горизонтальный, вертикальный или повернутый размеры. Коман-
да вызывается из падающего меню Dimension>Linear  или щелчком 
мыши по пиктограмме Linear Dimension на панели инструментов 
Dimension.:  

Ключи команды DIMLINEAR : 
• Mtext  – позволяет редактировать размерный текст в редакторе 

многострочного текста. Можно полностью изменить текст или сохра-
нить измеренное значение с помощью угловых скобок и при необхо-
димости добавить любой текст до и после скобок  

• Text – позволяет редактировать размерный текст. При этом 
выдаётся запрос:  

− Enter dimension text <измеренное значение>: – ввести необ-
ходимую текстовую строку; 

• Angle – позволяет задать угол поворота размерного текста;  
• Horizontal  – определяет горизонтальную ориентацию размера, 

отмеряет расстояние между двумя точками по оси X;  
• Vertical  – определяет вертикальную ориентацию размера, от-

меряет расстояние между двумя точками по оси Y;  
• Rotated – осуществляет поворот размерной и выносных ли-

ний, отмеряет расстояние между двумя точками вдоль заданного на-
правления в текущей ПСК. При этом выдаётся запрос:  

− Specify angle of dimension line <0>: – указать угол поворота 
размерной линии.  
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Рис. 1.47. Простановка горизонтального размера 
 

 
 

Рис. 1.48. Простановка вертикального размера 
 

 
 

Рис. 1.49. Простановка повёрнутого размера 
 
Параллельный размер. С помощью команды DIMALIGNED  

создаётся размер, параллельный измеряемой линии объекта; это позво-
ляет выровнять размерную линию по объекту. Команда вызывается из 
падающего меню Dimension > Aligned или щелчком мыши по пикто-
грамме Aligned Dimension на панели инструментов Dimension. Запросы 
команды DIMALIGNED : Specify first extension line origin or <select 
object>: – указать начало первой выносной линии; Specify second 
extension line origin: – указать начало второй выносной линии; Specify 
dimension line location or [Mtext/Text/Angle]: – указать положение раз-
мерной линии Dimension text = измеренное значение. 

 

 
 

Рис. 1.50. Простановка параллельного размера 
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Базовые размеры. Базовые размеры и размерные цепи пред-
ставляют собой последовательность линейных размеров. Базовые раз-
меры – это последовательность размеров, отсчитываемых от одной 
базовой линии (рис. 1.51). Перед построением базового размера или 
цепи на объекте должен быть проставлен хотя бы один линейный, ор-
динатный или угловой размер. Команда DIMBASELINE  позволяет 
создавать базовые размеры. Вызывается она из падающего меню 
Dimension > Baseline или щелчком мыши по пиктограмме Baseline 
Dimension на панели инструментов Dimension.  

 

 
 

Рис. 1.51. Простановка базовых размеров 
 
Размерная цепь. Команда DIMCONTINUE  позволяет создавать 

последовательную размерную цепь (рис. 1.52). Команда вызывается из 
падающего меню Dimension>Continue или щелчком мыши по пикто-
грамме Continue Dimension на панели инструментов Dimension. За-
просы команды DIMCONTINUE : Specify a second extension line 
origin or [Undo/Select] <Select>: – указать начало второй выносной 
линии; Dimension text = измеренное значение Specify a second 
extension line origin or [Undo/Select] <Select>: – указать начало сле-
дующей выносной линии; Dimension text = измеренное значение 
Specify a second extension line origin or [Undo/Select] <Select>: – ука-
зать начало следующей выносной линии; Dimension text = измеренное 
значение Specify a second extension line origin or [Undo/Select] 
<Select>: – указать начало следующей выносной линии или нажать 
клавишу Enter Select continued dimension: – выбрать исходный раз-
мер или нажать клавишу Enter для завершения команды. Если преды-
дущий размер не был линейным или если в ответ на первый запрос 
была нажата клавиша Enter, то предлагается выбрать линейный раз-
мер, который будет использован для продолжения. При этом выдаётся 
следующий запрос: Select continued dimension: – выбрать исходный 
размер. Далее следуют стандартные запросы команды 
DIMCONTINUE .  
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Рис. 1.52. Простановка последовательной размерной цепи 
 
Радиальные размеры. Команда DIMDIAMETER  строит диа-

метр окружности или дуги (рис. 1.53). Команда вызывается из падаю-
щего меню Dimension > Diameter или щелчком мыши по пиктограмме 
Diameter Dimension на панели инструментов Dimension.  

Имеется возможность произвести принудительное размещение 
размерного текста и линии-выноски внутри круга или дуги. 

 

 
 

Рис. 1.53. Простановка диаметра 

 
Команда DIMRADIUS , позволяющая построить радиус окружно-

сти или дуги (рис. 1.54), вызывается из падающего меню Dimension > 
Radius или щелчком мыши по пиктограмме Radius Dimension на па-
нели инструментов Dimension. Запросы DIMRADIUS  аналогичны за-
просам команды DIMDIAMETER . По умолчанию при простановке 
радиуса текст начинается с символа R.  

 
 

 
 

Рис. 1.54. Простановка радиуса 
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Угловые размеры. Команда DIMANGULAR  позволяет проста-
вить угловой размер. Она вызывается из падающего меню Dimension > 
Angular  или щелчком мыши по пиктограмме Angular  Dimension на 
панели инструментов Dimension. Запросы команды DIMANGULAR : 
Select arc, circle, line, or <specifу vertex>: –выбрать дугу, круг, отре-
зок; Select second line: – если первое указание было отрезком, следует 
указать второй отрезок, не параллельный первому; Specify dimension 
arc line location or [Mtext/Text/Angle]: – указать местоположение раз-
мерной линии Dimension text = измеренное значение. Если в ответ на 
первый запрос нажата клавиша Enter, то угловой размер строится по 
трем точкам и команда DIMANGULAR  выдает следующие запросы: 
Specify angle vertex: – выбрать вершину угла; Specify first angle 
endpoint: – указать первую конечную точку угла; Specify second angle 
endpoint: – указать вторую конечную точку угла; Specify dimension 
arc line location or [Mtext/Text/Angle]:  – указать местоположение раз-
мерной линии Dimension text = измеренное значение. При простанов-
ке углового размера текст по умолчанию завершается знаком градуса. 

 

 
 

Рис. 1.55. Простановка углового размера 

 
Ординатные размеры. Ординатные размеры определяют рас-

стояние по оси координат от базовой точки до образмериваемого объ-
екта (например, до отверстия в детали). Применение таких размеров 
предохраняет от накапливающихся ошибок, поскольку положение 
объектов отмеряется от единой базовой точки. Ординатный размер 
состоит из значения координаты х или у и выноски. Ординатный раз-
мер по X выражает расстояние от начала координат до объекта вдоль 
оси X, а ординатный размер по У – соответственно вдоль оси Y. Если 
указана точка, AutoCAD  автоматически определяет, по какой оси про-
ставлять ординатный размер. Такой способ называется автоматиче-
ским нанесением ординатных размеров. Выноска-отрезок или каждый 
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сегмент выноски-ломаной отрисовывается перпендикулярно одной из 
осей координат, поэтому целесообразно включать режим ORTHO .  

Выноской называется линия, соединяющая на рисунке поясни-
тельную надпись с объектом, к которому она относится. Выноски и 
пояснительные надписи ассоциативны, т.е. при редактировании одного 
из этих объектов соответственно изменяется и другой. Выноску, со-
стоящую из прямолинейных или сплайновых сегментов, можно начать 
от любой точки и от любого объекта рисунка. Все свойства выноски, 
её цвет, вес линии, масштаб, тип стрелки, размер и прочее определя-
ются установкой текущего размерного стиля для первой размерной 
стрелки. Пояснительные надписи могут представлять собой много-
строчные тексты, рамки допусков формы и расположения поверхно-
стей или вхождения блоков. Тексты пояснительных надписей вводятся 
построчно в командной строке или в диалоговом окне Text 
Formatting , если был введен Enter на запрос Enter first line of 
annotation text <Mtext>: – ввести первую строку текста пояснения. 
Параметры пояснения, линии-выноски и стрелки, а также способ рас-
положения текста относительно выноски можно задать в диалоговом 
окне Leader Settings:  

• на вкладке Annotation, показанной на рис. 1.56, задаётся тип 
пояснения, для которого строится выноска. В качестве пояснений мо-
гут использоваться многострочный текст, копии объектов, рамки до-
пусков формы и расположения, блоки. Параметр Copy an Object по-
зволяет использовать в качестве пояснения уже имеющийся объект, не 
создавая новый. Здесь можно также указать режимы многострочного 
текста и настроить повторное использование пояснения для после-
дующих выносок;  

• на вкладке Leader Line & Arrow , представленной на  
рис. 1.57, указывается тип линии-выноски: ломаная Straight или сплай-
новая Spline. В области Arrowhead из раскрывающегося списка мож-
но выбрать тип стрелки, а в области Angle Constraints задать ограни-
чения углов для сегментов выноски. Чтобы обеспечить быстрое нане-
сение выносок, можно в области Number of Points указать количество 
точек на выноске;  

• на вкладке Attachment, представленной на рис. 1.58, выбира-
ется способ расположения многострочного текста относительно вы-
носки. 

Для загрузки диалогового окна Leader Settings необходимо вы-
брать из падающего меню пункты Dimension > Leader, а затем нажать 
клавишу Enter.  
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Рис. 1.56. Диалоговое окно параметров выноски 
 

 
 

Рис. 1.57. Вкладка выносок и стрелок 
 

 
 

Рис. 1.58. Диалоговое окно параметров выноски, вкладка Attachment 
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Быстрое нанесение размеров. Команда QDIM  обеспечивает 
быстрое нанесение размеров. Она вызывается из падающего меню 
Dimension > QDIM  или щелчком мыши по пиктограмме Quick 
Dimension на панели инструментов Dimension. Запросы команды 
QDIM : Select geometry to dimension: – выбрать объекты для нанесе-
ния размеров; Select geometry to dimension: – выбрать объекты для 
нанесения размеров; Select geometry to dimension: – нажать клавишу 
Enter по завершении выбора объектов; Specify dimension line position, 
or [Continuous/Staggered/Baseline/Ordinate/Radius/Diameter/datum-
Point /Edit/ SeTt ings] <Continuous>: – указать местоположение раз-
мерной линии. Команда QDIM  запрашивает лишь указание контуров, 
на которые необходимо проставить размеры, и требует выбрать тип 
проставляемых размеров путём установки соответствующего ключа.  

 

 
 

Рис. 1.59. Быстрое нанесение размеров 
 

1.2.3. УПРАВЛЕНИЕ РАЗМЕРНЫМИ СТИЛЯМИ 
 

Размерный стиль – это поименованная совокупность значений 
всех размерных переменных, определяющая вид размера на рисунке. 
Команда DIMSTYLE  обеспечивает работу с размерными стилями в 
диалоговом окне Dimension Style Manager (рис. 1.60). Команда вызы-
вается из падающего меню Dimension > Style... или щелчком мыши по 
пиктограмме Dimension Style на панели инструментов Dimension. 

Диспетчер размерных стилей позволяет выполнить множество 
различных задач:  

• создать новый размерный стиль;  
• изменить имеющийся размерный стиль;  
• установить текущий стиль;  
• просмотреть размерные стили рисунка и их свойства;  
• воспользоваться предварительным просмотром размерных 

стилей;  
• сравнить два размерных стиля или создать перечень всех 

свойств стиля;  
• переименовать размерные стили;  
• удалить размерные стили.  
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Рис. 1.60. Диалоговое окно управления размерными стилями 
 
Размерные стили задают внешний вид и формат размеров. Они 

позволяют обеспечить соблюдение стандартов и упрощают редактиро-
вание размеров. Размерный стиль определяет следующие характери-
стики:  

• формат и положение размерных линий, линий-выносок, стре-
лок и маркеров центра;  

• внешний вид, положение и поведение размерного текста;  
• правила взаимного расположения текста и размерных линий;  
• глобальный масштаб размера;  
• формат и точность основных, альтернативных и угловых единиц;  
• формат и точность значений допусков.  
Для нанесения размера AutoCAD  применяет текущий размерный 

стиль. По умолчанию в качестве такового используется ISO-25 
(International Standards Organization), если пользователем не задан 
иной. Стиль STANDARD создан на основе стандарта ANSI (American 
National Standards Institute, США), хотя и не полностью с ним совпа-
дает. Если в рисунке используются британские единицы, то стиль 
STANDARD применяется по умолчанию. Стили DIN  (Германия) и JIS 
(Japanese Industrial Standards, Япония) имеются в шаблонах рисунков 
AutoCAD  DIN  и JIS. Определение базового размерного стиля следует 
начать с присвоения ему имени и сохранения. Новый стиль базируется 
на текущем и включает в себя все последующие изменения расположе-
ния размерных элементов, размещения текста и вида пояснительных 
надписей. Для создания нового размерного стиля необходимо в диало-
говом окне Dimension Style Manager щелкнуть мышью по кнопке New.... 
Откроется диалоговое окно Create New Dimension Style (рис. 1.61). 
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Рис. 1.61. Диалоговое окно создания размерного стиля 
 
После введения в поле New Style Name: имени создаваемого раз-

мерного стиля на экране появится диалоговое окно New Dimension 
Style, показанное на рис. 1.62.  

 

 
 

Рис. 1.62. Диалоговое окно определения параметров размерного стиля: 
вкладка линий и стрелок 

 
Диалоговое окно New Dimension Style содержит следующие 

вкладки:  
• вкладка Lines and Arrows (см. рис. 1.62) позволяет осуществ-

лять:  
− управление внешним видом размерных линий в области 

Dimension Lines, а также их подавление при установке флажков Dim 
Line 1 и Dim Line 2 в поле Suppress;  

− управление внешним видом выносных линий в области 
Extension Lines, их подавление при установке флажков Ext Line 1 и 
Ext Line 2 в поле Suppress:, a также удлинение выносных линий за 
размерные в поле Extend beyond dim lines: и настройка отступа вынос-
ных линий от объекта в поле Offset from origin ;  
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− управление формой размерных стрелок в области Arrowheads, 
их геометрией у первой/второй точек в полях 1st: и 2nd:, а также раз-
мерами стрелок в поле Arrow  size:;  

− управление формой маркеров центра в области Center Marks 
for Circles, их геометрией в раскрывающемся списке Туре: и размером 
в поле Size:;  

• вкладка Text обеспечивает управление размерным текстом: 
его стилем, высотой, местоположением относительно размерной ли-
нии, зазором между текстом и размерной линией и пр. (рис. 1.63):  

− список Text style: в области Text Appearance содержит тек-
стовые стили, используемые в текущем рисунке. Чтобы создать или 
отредактировать текстовый стиль, следует нажать кнопку, располо-
женную рядом с этим списком, и тем самым загрузить диалоговое ок-
но Text Style;  

− для установки цвета текста и обведения надписи рамкой пред-
назначены соответственно список Text color: и опция Draw frame 
around text;  

− если в текстовом стиле задана фиксированная высота, она 
имеет приоритет перед величиной, указанной в списке Text height:. 
Поэтому, чтобы пользователь имел возможность изменять данный па-
раметр на вкладке Text, высота в описании используемого текстового 
стиля должна быть равна 0;  
 

 
 

Рис. 1.63. Диалоговое окно определения параметров размерного стиля, 
вкладка управления размерным текстом 
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− в области Text Placement определяется размещение текста от-
носительно размерных и выносных линий, а также образмериваемого 
объекта. Результат действия каждой опции сразу можно просмотреть 
на образце. Для того чтобы текст располагался по вертикали, следует 
использовать список Vertical :. Вариант Centered позволяет разместить 
текст в центре, с разрывом размерной линии; Above – над размерной 
линией и параллельно ей. Обе опции учитывают направление осей X и Y. 
Outside означает, что текст всегда размещается за пределами образме-
риваемого объекта независимо от направления осей X и Y; JIS – над 
размерной линией, даже если не параллельно ей. Опции вертикального 
выравнивания основаны на горизонтальных размерах. Для настройки 
расположения текста по горизонтали используется список Horizontal :. 
При этом параметр Centered позволяет разместить текст по центру 
между двумя выносными линиями; At Ext Line 1  выравнивает текст 
влево и располагает его у первой выносной линии вдоль размерной 
линии; At Ext Line 2  – вправо; Over Ext Line 1 – вдоль первой вынос-
ной линии; Over Ext Line 2 – вдоль второй выносной линии;  

• вкладка Fit позволяет установить правила взаимного располо-
жения размерных выносных линий и текста (рис. 1.64). Здесь же зада-
ётся глобальный масштаб для размеров:  

− в области Fit Options можно определить, как располагаются 
текст и стрелки при недостатке места для того и других между вынос-
ными линиями;  

− область Text Placement предназначена для установки правил 
перемещения размерного текста. Они применяются, если текст был 
помещён программой или вручную за пределы выносных линий. При 
этом текст может перемещаться вместе с размерной линией. Также он, 
может быть отодвинут от размерной линии. Отодвинутый размерный 
текст бывает нанесён с выноской или без выноски;  

− в области Scale for Dimension Features опция Use overall scale 
of: позволяет указать коэффициент масштаба для всех параметров раз-
мерного стиля, задающих размеры, расстояния и отступы, включая 
высоту текста и величину стрелок. По умолчанию он принимается 
равным 1.0. Для увеличения размерных элементов следует задать 
больший масштаб, для уменьшения – меньший. Если поставлен фла-
жок Scale dimensions to layout (paperspace), используется масштаб 
видового экрана относительно пространства листа;  

− две опции в области Fine Tuning управляют подгонкой раз-
мерных элементов; Place text manually when dimensioning даёт поль-
зователю возможность размещать текст вручную; Always draw dim 
tine between ext lines приводит к тому, что размерная линия размеща-
ется между выносными, даже если стрелки и размерный текст вынесе-
ны за их пределы;  
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Рис. 1.64. Диалоговое окно определения параметров размерного стиля, 
вкладка размещения 

 
• вкладка Primary Units  позволяет определить формат и точ-

ность основных линейных и угловых единиц, вид измеренных значе-
ний размеров (рис. 1.65):  

− в области Linear Dimensions задается формат для цепей, ли-
нейных, параллельных, ординатных и неугловых базовых размеров, а 
также для радиусов и диаметров: 

Unit format : – определяется формат единиц: научные, десятич-
ные, технические, архитектурные, дробные или установленные в 
Windows. В последнем случае единицы берутся из настроек языка и 
стандартов на панели управления;  

Precision – задаётся число десятичных знаков для единиц, и в за-
висимости от выбранных единиц показывается формат представления 
величин;  

Fraction format : – определяется формат дробных единиц: с гори-
зонтальной чертой, с косой чертой или в одну строку;  

Decimal separator: – назначается десятичный разделитель: точка, 
запятая или пробел. Если выбраны единицы, установленные в 
Windows, AutoCAD  использует десятичный разделитель, заданный в 
настройках языка и стандартов на панели управления;  

Round off: – устанавливается точность округления величин всех 
линейных размеров. Здесь можно вводить любое число, содержащее до 
пяти десятичных знаков. Значение для округления не должно превы-
шать величину точности, заданную на этой закладке;  
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Prefix: – указание префикса, добавляемого перед величиной раз-
мера. Заданный здесь префикс заменяет обозначения радиуса и диа-
метра, которые AutoCAD  автоматически проставляет для соответст-
вующих размеров. Для записи префикса можно использовать специ-
альные символы и управляющие коды; Suffix: – указание суффикса, 
проставляемого после величины размера. Для записи суффикса можно 
использовать специальные символы и управляющие коды;  

 

 
 

Рис. 1.65. Диалоговое окно определения параметров размерного стиля, 
вкладка определения основных единиц 

 

− в области Measurement Scale производятся следующие на-
стройки:  

Scale factor: – измеренные величины размеров (линейных, парал-
лельных, радиусов, диаметров, ординатных, базовых, цепей) умножа-
ются на заданный здесь масштабный коэффициент; Apply to layout 
dimensions only: – масштабный коэффициент применяется только к 
размерам, нанесённым на листах;  

− в остальных областях вкладки Primary Units  устанавливаются 
параметры угловых размеров и подавления нулей;  

• вкладка Alternate Units позволяет определить формат и точ-
ность альтернативных единиц, которые используются для обозначения 
величин размеров в дополнительной системе единиц (рис. 1.66).  

Обычно с их помощью проставляются значения размеров в мет-
рических единицах, если рисунок выполнен в британской системе, и 
наоборот. Величина размера в альтернативных единицах наносится в 
квадратных скобках [ ] непосредственно после размерного текста в 
основных единицах. Для нанесения в размерах альтернативных единиц 
следует установить флажок Display alternate units. Для альтернативных 
единиц можно задать ещё два дополнительных параметра:  
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Рис. 1.66. Диалоговое окно определения параметров размерного стиля, 
вкладка определения альтернативных единиц 

 
− Multiplier for alt units : – альтернативные единицы получают-

ся путем умножения основных единиц на заданный здесь коэффици-
ент. По умолчанию предлагается коэффициент 0,03937, используемый 
для пересчета миллиметров в дюймы;  

− Placement – настраивается размещение альтернативных еди-
ниц после или под альтернативными единицами. При выборе парамет-
ра Below primary value основные единицы размещаются над размерной 
линией, а альтернативные – под ней; 

• вкладка Tolerances – управляет параметрами формата и точ-
ности простановки допусков, показывающих пределы, в которых мо-
жет варьироваться размер (рис. 1.67):  

− в области Tolerance Format настраиваются следующие пара-
метры нанесения допусков:  

Method: – способ нанесения допусков. Выбор None отключает 
нанесение допусков. Если верхнее и нижнее отклонения равны, ис-
пользуется параметр Simmetrical, если же различаются – параметр 
Deviation. С помощью опции Limits  можно указать максимальную и 
минимальную величины размера. Параметр Basic, позволяющий по-
строить рамку вокруг размерного текста, обычно используется для 
обозначения теоретически точных размеров; Precision – число деся-
тичных разрядов в значениях допусков;  

Upper value: – максимальное значение при нанесении отклонений 
и предельных размеров. AutoCAD  использует эту же величину для 
симметричных допусков;  
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Рис. 1.67. Диалоговое окно определения параметров размерного стиля, 
вкладка простановки 

 
Lower value: – минимальное значение при нанесении отклонений 

и предельных размеров;  
Scaling for height: – отношение высоты текста допусков к высоте 

основного размерного текста;  
Vertical position: – вертикальное выравнивание текстов симмет-

ричных допусков и отклонений. Для выравнивания текста допуска по 
верхней границе размерного текста используется опция Тор, по сере-
дине текста – Middle , а по нижней границе – Bottom.  

 
1.3. РЕДАКТИРОВАНИЕ ЧЕРТЕЖЕЙ 

 

1.3.1. ВЫБОР ОБЪЕКТОВ 
 

Большинство команд редактирования AutoCAD  требует предва-
рительного указания объектов для работы с ними. Выбранные объекты – 
один или несколько – называются набором. Он может, например, 
включать в себя все объекты определённого цвета или объекты, распо-
ложенные на определённом слое. Такой набор можно создать как до, 
так и после вызова команды редактирования. С одним и тем же набо-
ром допустимо производить несколько операций редактирования. Если 
установлена системная переменная HIGHLIGHT , выбранные объекты 
будут подсвечены. После того как вызвана одна из команд редактиро-
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вания, AutoCAD  предлагает выбрать объекты. В командной строке 
появляется запрос: Select objects: – выбрать объекты. При этом пере-
крестье указателя мыши заменяется на прицел выбора. Выбор отдель-
ных объектов производится с помощью мыши или одним из способов, 
которые описаны ниже в этом разделе. Способы и ключи выбора объ-
ектов:  

• Add – включает режим добавления для пополнения, сущест-
вующего набора. Это начальный режим, устанавливаемый для выбора 
объектов;  
 

 
 

Рис. 1.68. Диалоговое окно быстрого выбора 
 

 
 

Рис. 1.69. Диалоговое окно определения фильтр-списков 
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• ALL  – позволяет выбрать все примитивы, в том числе те, ко-
торые расположены на отключённых, заблокированных и заморожен-
ных слоях;  

• AUto – выделяет объект, на который установлен указатель 
мыши. Если не было выбрано ни одного объекта, указанная точка ста-
новится первым углом рамки;  

• BOX – задаёт прямоугольник по двум точкам. Если вторая 
точка находится справа от первой, процесс выбора аналогичен выбору 
рамкой Window, а если слева – выбору секущей рамкой Crossing;  

• Crossing – секущая рамка выделяет все объекты, которые на-
ходятся внутри или пересекают контур рамки. По умолчанию в ответ 
на запрос Select objects: можно указать первый угол рамки, а затем 
второй в направлении справа налево. Для того чтобы объект можно 
было выбрать, он должен быть хотя бы частично видимым. При выбо-
ре секущей рамкой в командной строке появляются запросы:  

Select ob jects: С – переход в режим выбора объектов с помощью 
секущей рамки Specify first corner: – указать первый угол рамки 
Specify opposite corner: – указать другой угол рамки. 

• CPolygon – сочетает режимы и позволяет выбрать объекты 
как полностью заключённые в многоугольник, так и пересекающие его 
границу. Область задаётся путём указания точек вокруг объектов, ко-
торые следует выбирать. Многоугольник строится по мере установки 
этих точек; он может быть любой формы, но без самопересечений, и 
автоматически замыкается при указании каждой новой вершины. От 
последней заданной точки до указателя мыши протянута «резиновая 
нить». При этом в командной строке появляются запросы:  

Для формирования набора объектов с помощью функции быстро-
го выбора следует выбрать из падающего меню Tools > Quick Select... 
и в открывшемся диалоговом окне Quick Select установить необходи-
мые параметры (рис. 1.68). Для настройки более сложных фильтров и 
сохранения их под заданными именами достаточно в ответ на запрос 
Select objects: ввести ' filter и в диалоговом окне Object Selection 
Filters, показанном на рис. 1.69, определить фильтр-список.  

 
1.3.2. РЕДАКТИРОВАНИЕ С ПОМОЩЬЮ РУЧЕК 

 

Выбранными объектами можно манипулировать с помощью ру-
чек – маленьких квадратиков, которые высвечиваются в определяю-
щих точках выбранных объектов (рис. 1.70). При включённом режиме 
работы с ручками выбор объектов производится до редактирования, а 
манипуляции с ними выполняются с помощью указателя мыши или 
ключевых слов. Таким образом, использование ручек позволяет мини-
мизировать обращения к меню. 
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Рис. 1.70. Примеры примитивов с ручками 
 
Графический курсор привязывается к ручке, по которой он про-

ходит. Если режим работы с ручками включён, то объекты, удаляемые 
из набора, перестают подсвечиваться, но ручки на них остаются. Уда-
ление ручек из набора объектов производится нажатием клавиши Esc. 
Для удаления из набора, содержащего ручки, какого-либо объекта следу-
ет нажать клавишу Shift при его выборе. Определением ручек в блоках 
управляет системная переменная GRIPBLOCK . Если она равна 1, ручки 
устанавливаются на всех объектах, входящих в блок, а если 0, на блоке 
изображается только одна ручка в точке его вставки. Для включения 
ручек используется команда DDGRIPS. При этом все установки назна-
чаются на вкладке Selection диалогового окна Options. Оно вызывается 
из падающего меню Tools > Options. Параметры ручек устанавливаются 
в следующих областях:  

• Grip Size – определяет размер ручек при регулировании 
движком. При этом на экранчике слева от движка показан текущий 
размер ручек;  

• Grips – ручки:  
• в раскрывающемся списке Unselected grip color: задаётся цвет 

невыбранных ручек;  
• в раскрывающемся списке Selected grip color: задаётся цвет 

выбранных ручек;  
• в раскрывающемся списке Hover grip color:  задаётся цвет 

ручки под указателем мыши;  
• установка флажка Enable grips активизирует ручки для всех 

выбранных объектов;  
• установка флажка Enable grips within blocks обеспечивает 

выбор объектов с помощью ручек внутри блоков;  
• установка флажка Enable grip tips: позволяет задать подсказ-

ки к ручкам.  
Для редактирования с помощью ручек нужно выбрать ручку, точ-

ка расположения которой будет базовой точкой редактирования. После 
этого выбирается один из режимов ручек: перенести – Move, зеркало – 
Mirror , повернуть – Rotate, масштаб – Scale или растянуть – Stretch. 
Например, для установки режима Stretch нужно ввести S или нажи-
мать Enter до тех пор, пока в командной строке не появится ключ 



46 

Stretch. Чтобы выйти из режима работы с ручками и вернуться к под-
сказке Command:, необходимо ввести X или нажать клавишу Esc. 
Наиболее удобный способ выбора режима редактирования с помощью 
ручек – использование контекстного меню ручки (рис. 1.71), которое 
открывается нажатием правой кнопки мыши при выделенной ручке. 

 

 
 

Рис. 1.71. Контекстное меню ручки 
 
Если при указании в команде редактирования первого нового по-

ложения для объекта нажата клавиша Shift, активизируется режим 
многократного копирования. Например, в режиме Stretch функция 
многократного копирования растягивает объект, такой как отрезок, и 
копирует его в любую точку графической области, указанную пользо-
вателем. 

 
1.3.3. УДАЛЕНИЕ И ВОССТАНОВЛЕНИЕ ОБЪЕКТОВ 

 

Команда ERASE осуществляет удаление (стирание) объектов. 
Она вызывается из падающего меню Modify  > Erase или щелчком 
мыши по пиктограмме Erase на панели инструментов Modify . Запросы 
команды ERASE: Select objects: – выбрать объекты Select objects: – 
выбрать объекты Select objects: – нажать клавишу Enter для заверше-
ния работы команды. Выбор объектов, которые следует стереть, может 
производиться любым из доступных способов. Для восстановления 
удалённых последней командой ERASE объектов используется ко-
манда OOPS; её название – «ОЙ» – весьма удачно отражает эмоции 
пользователя, испытываемые в момент применения этой команды.  

 

 
 

Рис. 1.72. Удаление объектов 
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2. ВОПРОСЫ ДЛЯ ПОДГОТОВКИ К ЭКЗАМЕНАМ 
 

 

1. Методы проецирования. 
2. Проецирование точки и прямой на две и три плоскости проек-

ций. 
3. Прямые общего и частного положения. 
4. Взаимное положение прямых в пространстве. Метод конкури-

рующих точек. 
5. Определение натуральной величины отрезка прямой общего 

положения и углов его наклона к плоскости проекций. 
6. Деление отрезка прямой в данном отношении. 
7. Проецирование прямого угла. 
8. Следы прямой. 
9.  Задание плоскости на чертеже. 
10. Плоскости общего и частного положения. 
11. Принадлежность точки и прямой плоскости. 
12. Главные линии плоскости. 
13. Общий приём построения точки пересечения прямой линии с 

плоскостью. 
14. Признак параллельности и перпендикулярности прямой и 

плоскости. 
15. Признак параллельности и перпендикулярности двух плоско-

стей. 
16. Построение линии пересечения двух плоскостей. Определение 

видимости. 
17. Сущность способов преобразования чертежа вращением и за-

меной плоскостей проекций. 
18. Способ вращения и его разновидности. Вращение вокруг про-

ецирующей оси. 
19. Способ вращения вокруг линии уровня и следа плоскости. 

Способ плоско-параллельного перемещения. 
20. Плоские и пространственные кривые линии. 
21. Поверхности. Многогранные поверхности. 
22. Способ граней. Развёртывание многогранных поверхностей 

способом нормального сечения. 
23. Способ рёбер. Развёртывание многогранных поверхностей 

способом триангуляции. 
24. Кривые поверхности (поверхности линейчатые развёртывае-

мые и неразвёртываемые, поверхности нелинейчатые, поверхности 
вращения). 

25. Пересечение кривых поверхностей прямой линией и плоско-
стью. 
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26. Взаимное пересечение кривых поверхностей. Метод вспомо-
гательных секущих плоскостей. 

27. Метод концентрических сфер для построения линии пересече-
ния двух поверхностей вращения. 

28. Развёртывание кривых поверхностей. 
29. Тени. Выбор направления светового луча при построении те-

ней в ортогональных проекциях. Понятия о собственных и падающих 
тенях. 

30. Тени от точки, прямой и плоскости. 
31. Методы построения теней. Метод лучевых сечений. 
32. Методы построения теней. Метод обратного луча. 
33. Перспектива. Геометрические основы линейчатой перспекти-

вы. 
34. Перспектива точки, прямой и плоскости. 
35. Выбор проведения основания картинной плоскости, угла зре-

ния и высоты горизонта. 
36. Методы построения перспективных изображений. 
37. Построение перспективных изображений методом архитекто-

ров. 
38. Построение теней в перспективе. 
39. Проекции с числовыми отметками. Сущность метода. 
40. Проекции точек и прямых в числовых отметках. 
41. Взаимное положение прямых в проекциях с числовыми отмет-

ками. 
42. Плоскость в проекциях с числовыми отметками. Взаимное по-

ложение плоскостей. 
43. Поверхности в проекциях с числовыми отметками. 
44. Топографическая поверхность в проекциях с числовыми от-

метками. 
45. Взаимное пересечение поверхностей в проекциях с числовыми 

отметками. 
46. Аксонометрические проекции. Сущность метода. Теорема 

Польке. 
47. Виды аксонометрических проекций. Прямоугольная диметрия. 
48. Виды аксонометрических проекций. Прямоугольная изомет-

рия. 
49. Построение наглядных изображений в прямоугольной изомет-

рии и диметрии. 
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3. ЗАДАЧИ ДЛЯ ПОДГОТОВКИ К ЭКЗАМЕНАМ 
 

 

Тема 1. ТОЧКА, ПРЯМАЯ ПЛОСКОСТЬ 
 

1. По координатам точек построить их наглядное изображение и 
комплексный чертеж: A(25, 25, 25), B(0, 10, 15), C(35, 0, –5),  
D(15, –20, –10), E(40, 0, 0), F(10, 15, 0). 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

П2 

0 

П1 

x 

z 

0 

y 

x 
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 x y z 
A    
B    
C    
D    
E    

2. Построить комплексные чертежи  
точек по их координатам:  
A(5, 10, 15), B (0, 25, 30), C(25, 0, 0). 

4. По двум проекциям точек  
A, B, C, D, E построить третьи,  
указать их координаты. 

3. Построить горизонтальную и 
фронтальную проекции 
прямой AB по заданным 
координатам её концов: 
A(25, 10, 35), B (5, 5, 10). 

5. Построить проекции отрезка AB 
длиной 45 мм: 
а) параллельно фронтальной плоско-
сти. На отрезке прямой AB взять точ-
ку E, равноудаленную от плоскостей 
П1 и П2; 
б) параллельно профильной плоско-
сти проекций и под углом 30° к плос-
костям П1 и П2. 

z 

y 

y x 

A2 

B2 

A1 

x y 

C2 

C1 

D2 

D1 

B1 

z 

E2 

y E1

y 

y 

x 

z 

a) 

y 

x 

б) 
z 

x 

y 

y 
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6. Построить недостающие 
проекции прямых AB и CD. 

7. Пересечь прямые AB, CD и EF
прямой, параллельной горизон-
тальной плоскости проекций. 

8. Через точку C провести прямую 
CD, пересекающую прямую AB и 
ось z. 

9. На отрезке прямой AB взять 
точку E, равноудаленную от 
плоскостей П1 и П2. 

а) 

б) 

B2 

A1 

A2 

x y 

z 

B1 

y 

A1 

y 

y x 

B2 

C2 

D1 

D2 

C1 

A2 z 

F3 

E1≡F1 

E3 

C3 

D2 
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C2 

B1 

x y x 
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C2 
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B1 

A1 
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B2 

B1 

A2 

y 
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Тема 2. ДЕЛЕНИЕ ОТРЕЗКА В ДАННОМ ОТНОШЕНИИ.  
ОПРЕДЕЛЕНИЕ ИСТИННОЙ ВЕЛИЧИНЫ ОТРЕЗКА ПРЯМОЙ. 

ПРОЕЦИРОВАНИЕ ПРЯМОГО УГЛА. СЛЕДЫ ПРЯМОЙ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Разделить отрезки AB и CD в 
отношении 5:1. 

12. Определить расстояние от точ-
ки C до фронтальной прямой AB. 

11. На прямой AB отложить отре-
зок, равный 30 мм и определить 
угол наклона прямой AB к плоско-
сти П1. 

13. Построить равнобедренный 
треугольник ABC с основанием BC 
и вершиной A, лежащей на прямой 
EF. 

14. Построить квадрат ABCD со 
стороной BC на горизонтальной 
прямой MN. 

15. В плоскости α (AB||BC) постро-
ить горизонталь, фронталь и линию 
наибольшего наклона к плоскости 
П1. 

D2 
B2 

C2 

C1 

A2 

D1 

x 
B1 

A1 

B2 

A2 

B2 

A2 

C2 

x 
C1 

A1 B1 

C2 

B2 

A1 

B1 x 
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C1 

B1 

E2 

F2 

M2 
N2 
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E1 F1 

C2 

x 

D2 

C1 

D1 

A2 

B2 

A1 
B1 N1 A1 

A2 

M1 
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16. Построить горизонтальный и 
фронтальный следы прямой AB. 

17. Построить проекции прямой AB
по её следам. Указать четверти, че-
рез которые проходит прямая. 

18. Построить следы плоскости α заданной четы-
рёхугольником ABCD. 

19. Построить недостающую проекцию прямой EF в 
плоскостях, заданных пересекающимися прямыми 
AB и AC (рис. а), и следами (рис. б). 

A2 

B2 

B1 
A1 

M ≡ M2 

N ≡ N2 

x x 

A1 

A2 

B1 

D2

B2 

C1 

C2 

D1 

x 

A2 

E2 B2 

F2 
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б) 

x 

F1 

E1 

а) 

C2 

C1 

A1 

B1 

x 

αП1 
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Тема 3. ПЕРЕСЕЧЕНИЕ ПЛОСКОСТЕЙ. ПЕРЕСЕЧЕНИЕ  
ПРЯМОЙ С ПЛОСКОСТЬЮ. ПЕРПЕНДИКУЛЯРНОСТЬ И  

ПАРАЛЛЕЛЬНОСТЬ ПРЯМЫХ И ПЛОСКОСТЕЙ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

20. По данным элементам построить следы 
плоскостей. 

21. Построить линии пересечения заданных плоскостей. 

22. Определить линии пересечения плоскостей α и β. 

а) 

а) 

B1 

B2 

A2 

A1 

C2 

C1 
x 

x 

α1 

A2 

A1 

б) 

С2 

A2 αП2 

x 

C1 

A1 

B2 

B1 

б) 

αП1 

h0α 

x 

αП2 

x 

βП2 

βП1 

αП1 
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23. Построить точку пересечения прямой AB с плоскостями, опреде-
лить видимость прямой. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
24. Построить линию пересечения плоскостей треугольника ABC и 
параллелограмма DEFG. Видимые части выделить штриховкой. 
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25. Определить расстояние от 
точки D до плоскости. 

26. Определить расстояние от точ-
ки A до прямой BC. 

27. Через точку D и прямую AB 
провести плоскость β (построить 
её следы), перпендикулярную к 
заданной плоскости α. 

28. Через точку A провести плос-
кость параллельную заданной. 
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Тема 4. СПОСОБ ПЕРЕМЕНЫ ПЛОСКОСТЕЙ ПРОЕКЦИЙ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

29. Определить истинную ве-
личину отрезка AB и угол его 
наклона к плоскости П1. 

31. Определить истинную величину 
расстояния между проводами AB и 
CD. 

30. Построить проекции и нату-
ральную величину перпендику-
ляра, опущенного из точки C на 
прямую AB. 

32. Определить точку пересечения 
EF и ABCD. 

B2 

П1 

П2 

A2 

A1 
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A2 
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x 
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F2 
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33. Определить натуральную вели-
чину двугранного угла между 
BCDA и FCDE. 

35. Способом перемены плоскостей про-
екций определить: 
а) угол наклона ската крыши BCEF к 
плоскости П1; 
б) расстояние от вершины В до ската 
BCEF; 
в) натуральную величину ската BCEF. 

34. Построить горизонтальную 
проекцию точки C, удалённой 
от прямой AB на 20 мм. 
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Тема 5. СПОСОБ ВРАЩЕНИЯ, ПЛОСКО-ПАРАЛЛЕЛЬНОГО 
ПЕРЕМЕЩЕНИЯ И СОВМЕЩЕНИЯ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

x x 

x x 

x 

C2 

A2 

B2 

C1 
B1 

A1 

36. На прямой AB построить точ-
ку C, если AC 15 мм. Задачу ре-
шить методами вращения вокруг 
оси, перпендикулярной к плоско-
сти П1 и плоско-параллельного 
перемещения 

37. Точку A, вращая вокруг оси O, 
ввести в заданную плоскость. 

39. Способом плоско-параллельного 
перемещения определить расстоя-
ние от точки C до прямой AB. 

38. Способом плоско-параллель-
ного перемещения определить 
расстояние от точки A до плоско-
сти треугольника BCD. 

A2 

B2 

A1 

B1 

A2 
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B1 C1 
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x 

C2 

B2 

C1 

B1 

40. Параллелограмм ABCD повер-
нуть вокруг фронтали на угол 30°
способом плоско-параллельного 
перемещения. 

41. Способом плоско-параллельного 
перемещения построить равносторон-
ний треугольник ABC со стороной BC 
на прямой MN. 

42. Способом вращения вокруг 
горизонтали определить истин-
ную величину угла ABC. 

A2 

A1 
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E2 
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x 

43. Определить величину 
угла между прямой AD и 
плоскостью BCDE. 
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44. Определить истинную величину угла
наклона между двумя плоскостями мето-
дом вращения вокруг фронтали. 

45. Способом совмещения определить истинную вели-
чину треугольника ABC, лежащего в плоскости α. 

46. Найти центр окружности, описанной около треугольника, лежаще-
го в плоскости α, способом совмещения с плоскостью П1. 

x C2 
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Тема 6. КРИВЫЕ ЛИНИИ И ПОВЕРХНОСТИ.  
ПЕРЕСЕЧЕНИЕ ПОВЕРХНОСТЕЙ ПЛОСКОСТЯМИ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

47. Построить недостающие 
проекции точек A и B, лежа-
щих на конической поверхно-
сти, заданной направляющей 
M и вершиной S. 

49. Построить проекции сечения пи-
рамиды плоскостью. Определить 
истинную величину сечения. 

48. Определить недостающие про-
екции точек A и B, принадлежа-
щих поверхности коноида. 
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51. Построить линии пересечения плоскости ABCD с 
поверхностью здания и плоскости EFMN с поверх-
ностью крыши. Указать видимость плоскостей и 
поверхностей. 

∝2 

50. Построить сечение конуса плоскостью ∞. 
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53. Построить полную развёртку пира-
миды SABCD. 

Тема 7. ПОСТРОЕНИЕ РАЗВЁРТОК.  
ВЗАИМНОЕ ПЕРЕСЕЧЕНИЕ ПОВЕРХНОСТЕЙ 

52. Построить развёртку боковой поверхности 
резервуара методом нормального сечения. 

A1 
D1 

D2 C2 

S1 
B1 

C1 

A2 B2 

S2 
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55. Построить линию пересече-
ния конуса и цилиндра. 

54. Построить линию пересечения 
сферического купола с плоскостя-
ми ABCD и CDEF скатов крыши. 

E1 

D2 
C2 

F1 

A2 B2 

A1 

B1 

E2 F2 

56. Построить линию пересечения усечён-
ных конусов методом сфер. 

C1 

D1 
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57. Построить линию пересечения конуса и цилиндра методом сфер. 

58. Построить линии пересечения схематизированного здания с при-
стройкой. 

D2 
C2 A2 

B2 

A1 

B1 
C1 D1 
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Тема 8. АКСОНОМЕТРИЧЕСКИЕ ПРОЕКЦИИ.  
ПЕРЕСЕЧЕНИЕ ПРЯМОЙ С ПОВЕРХНОСТЬЮ. ПЛОСКОСТИ, 

КАСАТЕЛЬНЫЕ К КРИВЫМ ПОВЕРХНОСТЯМ 
 
59. Построить прямоугольную изометрию крыльца. 
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61. Построить точки пересечения пря-
мой AB с поверхностью конуса. 

60. Построить проекции точек пе-
ресечения прямой AB с поверхно-
стью пирамиды SCDEF. 

A1 

D1 

D2 C2 

S1 

B1 

C1 

B1 

S2 

62. Построить проекции точек 
пересечения прямой AB с по-
верхностью сферы. 

A1 

B1 

A2 

B2 

E1 

F1 

F2 E2 

63. Построить плоскость, каса-
тельную в данной точке A к по-
верхности сферы. 

A1 

A2 

64. Построить плоскость, прохо-
дящую через данную точку A и 
касающуюся данного конуса. 

A2 

А2 ≡ B2 

A1 

A1 

A2 

B1 

B2 
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Тема 9. ПОСТРОЕНИЕ ТЕНЕЙ  
В ОРТОГОНАЛЬНЫХ ПРОЕКЦИЯХ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

66. Построить тень от круга. 

67. Построить тень от треугольни-
ка ABC. 

A2 

65. Построить тень от прямой AB. 

A1 

D1 

C2 ≡ D2 

C2 

B1 

S2 

S1 

B1 C1 

A2 

B2 

S2 

S1 

B2 

O1 

S2 

S1 

O2 

68. Построить тень от прямоуголь-
ника ABCD. 

A1 

S1 B1 C1 

S2 

A2 ≡ B2 

 

A1 

A2 

S2 

S1 

69. Построить тень от пирамиды SABCDEF. 

A1 

B1 C1 

D1 

E1 F1 

S2 

S1 

B2 ≡ F2 D2 C2≡ E2 
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71. Построить тень от антенны ABC. 70. Построить тень от шеста AB. 

A1 

C2 

A1 ≡ B1 
 

S1 

F1 

D2 

B2 

S2 

B2 

S2 

S1 
A2 C2 

D2 

E2 
F2 

G2 

H2 

E1 

F1 

C1 ≡ D1 
 

G1 ≡ H1 

 B1 ≡ C′ 
 

D1 

E1 

G1 
H1 

K1 

E2 H2 

G2 K2 A2 

74. Построить 
тень ниши и 
выступа. 

73. Построить тень от трубы на скат 
крыши. 

Тема 10. ТЕНИ ЭЛЕМЕНТОВ ЗДАНИЙ.  
ТЕНИ В АКСОНОМЕТРИЧЕСКИХ ПРОЕКЦИЯХ 

72. Построить собственные 
и падающие тени от плит-
козырьков. 

S2 

S1 

75. Построить фронтальную проекцию 
объекта по его горизонтальной проек-
ции и падающей тени на плоскость. 

S1 

S2 

76. Построить собственные и падаю-
щие тени от крыльца в ортогональных 
проекциях и изометрии по чертежу 
задачи 58. 
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Тема 11. ПРОЕКЦИИ С ЧИСЛОВЫМИ ОТМЕТКАМИ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A5 

B3 

Σi 

77. Построить линию пересечения двух плоскостей, 
заданных треугольником ABC и масштабом уклонов. 
Определить уклон и интервал линии пересечения 
плоскостей. 

С10

1 

А5 

B3

78. Построить линию пересечения плоскости, задан-
ной масштабом уклонов, с топографической поверх-
ностью. 
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79. Построить точку пересечения прямой AB с топографической по-
верхностью. 

B15 

A8 

80. Построить пересечение откоса, проходящего через 
отрезок AB, с местностью. 

A50 

B50 

      16   15     14   13          12        11          10      9     8 
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75



 

76
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ЗАКЛЮЧЕНИЕ 
 

 

В данном пособии представлены основные команды для выпол-
нения чертежей при помощи системы автоматизированного проекти-
рования AutoCad. Приведена информация о способах создания и ре-
дактирования изображений в AutoCad. 

Представлены индивидуальные задания по начертательной гео-
метрии и инженерной графике. 

Данное пособие развивает навыки выполнения чертежей при по-
мощи компьютера. 
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